VLAN Management
User Guide

Document 3543
Notice

Copyright Notice  Copyright © 2002 by Aprisma Management Technologies, Inc. All rights reserved worldwide. Use, duplication, or disclosure by the United States government is subject to the restrictions set forth in DFARS 252.227-7013(c)(1)(ii) and FAR 52.227-19.

Liability Disclaimer  Aprisma Management Technologies, Inc. ("Aprisma") reserves the right to make changes in specifications and other information contained in this document without prior notice. In all cases, the reader should contact Aprisma to inquire if any changes have been made.

The hardware, firmware, or software described in this manual is subject to change without notice.

IN NO EVENT SHALL APRISMA, ITS EMPLOYEES, OFFICERS, DIRECTORS, AGENTS, OR AFFILIATES BE LIABLE FOR ANY INCIDENTAL, INDIRECT, SPECIAL, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING BUT NOT LIMITED TO LOST PROFITS) ARISING OUT OF OR RELATED TO THIS MANUAL OR THE INFORMATION CONTAINED IN IT, EVEN IF APRISMA HAS BEEN ADVISED OF, HAS KNOWN, OR SHOULD HAVE KNOWN, THE POSSIBILITY OF SUCH DAMAGES.

Trademark, Service Mark, and Logo Information  SPECTRUM, IMT, and the SPECTRUM IMT/VNM logo are registered trademarks of Aprisma Management Technologies, Inc., or its affiliates. APRISMA, APRISMA MANAGEMENT TECHNOLOGIES, the APRISMA MANAGEMENT TECHNOLOGIES logo, MANAGE WHAT MATTERS, DCM, VNM, SpectroGRAPH, SpectroSERVER, Inductive Modeling Technology, Device Communications Manager, SPECTRUM Security Manager, and Virtual Network Machine are unregistered trademarks of Aprisma Management Technologies, Inc., or its affiliates. For a complete list of Aprisma trademarks, service marks, and trade names, go to:

http://www.aprisma.com/manuals/trademark-list.htm

All referenced trademarks, service marks, and trade names identified in this document, whether registered or unregistered, are the intellectual property of their respective owners. No rights are granted by Aprisma Management Technologies, Inc., to use such marks, whether by implication, estoppel, or otherwise. If you have comments or concerns about trademark or copyright references, please send an e-mail to spectrum-docs@aprisma.com; we will do our best to help.

Restricted Rights Notice  (Applicable to licenses to the United States government only.) This software and/or user documentation is/are provided with RESTRICTED AND LIMITED RIGHTS. Use, duplication, or disclosure by the government is subject to restrictions as set forth in FAR 52.227-14 (June 1987) Alternate III(g)(3) (June 1987), FAR 52.227-19 (June 1987), or DFARS 52.227-7013(c)(1)(ii) (June 1988), and/or in similar or successor clauses in the FAR or DFARS, or in the DOD or NASA FAR Supplement, as applicable. Contractor/manufacturer is Aprisma Management Technologies, Inc. In the event the government seeks to obtain the software pursuant to standard commercial practice, this software agreement, instead of the noted regulatory clauses, shall control the terms of the government's license.

Virus Disclaimer  Aprisma makes no representations or warranties to the effect that the licensed software is virus-free. Aprisma has tested its software with current virus-checking technologies. However, because no antivirus system is 100-percent effective, we strongly recommend that you write protect the licensed software and verify (with an antivirus system with which you have confidence) that the licensed software, prior to installation, is virus-free.

Contact Information  Aprisma Management Technologies, Inc., 273 Corporate Drive, Portsmouth, NH 03801 USA
Phone: 603.334.2100
U.S. toll-free: 877.468.1448
Web site: http://www.aprisma.com
Contents

Notice ......................................................................................................................... 2

Preface ..................................................................................................................... 4
   Intended Audience ................................................................................. 4
   Text Conventions ............................................................................... 4
   Document Feedback ......................................................................... 5
   Online Documents ........................................................................... 5

Introduction .............................................................................................................. 6
   VLAN Overview ................................................................................. 6
   SPECTRUM’s VLAN Support ............................................................. 6

Modeling VLANs ..................................................................................................... 7
   Modeling Prerequisites ....................................................................... 7
   Checking Your VLAN Configuration .............................................. 7
   Enabling SPECTRUM’s VLAN Support ........................................... 8
   Using AutoDiscovery to Create a VLAN Topology Model ............... 10
   Manual Modeling or Editing the VLAN Topology Model ............... 10

Managing VLANs ................................................................................................ 12
   The VLAN List View ....................................................................... 12
   The VLAN Topology Spanning Tree Overlay .................................. 14
   The User View ................................................................................ 15
   The Port View ................................................................................ 16
   The VLAN Domain Options View .................................................. 18

VLAN Fault Isolation .............................................................................................. 20

Index ..................................................................................................................... 22
Preface

In This Section

Intended Audience [page 4]
Text Conventions [page 4]
Document Feedback [page 5]
Online Documents [page 5]

Intended Audience

This guide is intended for system administrators who are using SPECTRUM to manage VLANs.

Text Conventions

The following text conventions are used in this document:

<table>
<thead>
<tr>
<th>Element</th>
<th>Convention Used</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variables</td>
<td>Courier and Italic in angle brackets (&lt;&gt;</td>
<td>Type the following: DISPLAY=&lt;workstation name&gt;:0.0 export display</td>
</tr>
<tr>
<td>The directory where you installed SPECTRUM</td>
<td>&lt;$SPECROOT&gt;</td>
<td>Navigate to: &lt;$SPECROOT&gt;/app-defaults</td>
</tr>
<tr>
<td>(The user supplies a value for the variable.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Solaris and Windows directory paths</td>
<td>Unless otherwise noted, directory paths are common to both operating systems,</td>
<td>&lt;$SPECROOT&gt;/app-defaults on Solaris is equivalent to &lt;$SPECROOT&gt;/app-defaults on Windows.</td>
</tr>
<tr>
<td>(The user supplies a value for the variable.)</td>
<td>with the exception that slashes (/) should be used in Solaris paths, and</td>
<td></td>
</tr>
<tr>
<td></td>
<td>backslashes () should be used in Windows paths.</td>
<td></td>
</tr>
<tr>
<td>On-screen text</td>
<td>Courier</td>
<td>The following line displays: path=&quot;/audit&quot;</td>
</tr>
<tr>
<td>User-typed text</td>
<td>Courier</td>
<td>Type the following path name: C:\ABC\lib\db</td>
</tr>
</tbody>
</table>
Document Feedback

Please send feedback regarding SPECTRUM documents to the following e-mail address:

spectrum-docs@aprisma.com

Thank you for helping us improve our documentation.

Online Documents

SPECTRUM documents are available online at:

http://www.aprisma.com/manuals

Check this site for the latest updates and additions.
Introduction

This section provides an overview of VLANs and describes how they are supported by SPECTRUM.

VLAN Overview

In general, bridges and switches replicate LAN broadcast traffic on all ports. However, in a VLAN domain, switches segment the network into individual, logically defined VLANs. Broadcast traffic from devices on a particular VLAN is replicated only on the switch’s ports that connect to that VLAN. Broadcast traffic is blocked from ports that do not connect to VLAN, creating the same type of broadcast containment that routers provide.

SPECTRUM’s VLAN Support

SPECTRUM recognizes VLAN switches and routers that support IEEE 802.1Q, Cisco ISL, and Cabletron SecureFast. Each VLAN domain must contain a set of VLAN enabled switches bound by a router or other routing device. This VLAN topology is called a one-armed router configuration.

For VLANs with the above configuration, SPECTRUM allows you to troubleshoot your VLAN environment using the following features:

- The VLAN Topology Spanning Tree overlay graphically illustrates the physical and spanning tree data path for the modeled VLAN domain.
- VLAN views specify connectivity and port information for a selected VLAN.
- SPECTRUM provides fault isolation capabilities that take into account the logical as well as the physical connectivity of the VLAN domain.
Modeling VLANs

This section discusses how to model a VLAN with SPECTRUM. Before you can begin to use SPECTRUM’s VLAN functionality to manage your VLANs, you must create an accurate model of the VLAN topology. To do this you can use SPECTRUM’s AutoDiscovery function, or you can manually model the devices and connections in the VLAN domain.

*In This Section*

- Modeling Prerequisites [page 7]
- Using AutoDiscovery to Create a VLAN Topology Model [page 10]
- Manual Modeling or Editing the VLAN Topology Model [page 10]

**Modeling Prerequisites**

Before you begin modeling your VLAN, you must make sure that your VLAN configuration is supported by SPECTRUM and that SPECTRUM’s VLAN functionality has been enabled.

**Checking Your VLAN Configuration**

SPECTRUM expects the VLAN domain being modeled to use a one-armed router configuration, i.e. each VLAN domain should contain a set of VLAN enabled switches bounded by a router or other routing device. *Figure 1* illustrates this configuration. It shows a VLAN domain that contains two VLANs. The Blue VLAN consists of workstations A, B and C, and the SpectroSERVER. The Red VLAN consists of workstations D, E, F, and G.

Any communication that goes between the two VLANs, e.g. from A to F, must go through the router. The router is usually connected to one of the switch ports and receives and forwards inter-VLAN traffic on the same port.

Communication within a VLAN, e.g. from D to E or B to C, does not go through the router.
Enabling SPECTRUM’s VLAN Support

Before modeling and managing a VLAN, you must enable the VLAN configuration support in the Landscape Configuration view using the following instructions.

1. Click on the VNM icon to highlight it.

2. Choose View > Icon Subviews > Configuration to bring up the Landscape Configuration View. The following window will appear.
3. By default, VLAN Configuration is set to **Disabled**. Reset this value to **Enabled**.

**WARNING!** Changing the value of the VLAN Configuration setting frequently may cause your SpectroSERVER to hang for a long period of time.

4. Choose **File > Save All Changes** to save this configuration change.

It is important to note that turning on VLAN support may cause some loss in SpectroSERVER performance.
Using AutoDiscovery to Create a VLAN Topology Model

SPECTRUM’s AutoDiscovery process will map the port-to-port connectivity of VLAN switches, including the connectivity of VLAN switch ports to routers and workstations.

To map the connectivity, AutoDiscovery reads information from IETF standard MIBs (i.e., the dot1dBridge MIB) including information from the spanning tree table and the forwarding database. Depending on device support and the management modules installed, AutoDiscovery will also query enterprise discovery protocol and source address MIBs. The supported enterprise MIBs include the Cisco Discovery Protocol MIB, the Extreme Discovery Protocol MIB, and the Cabletron Discovery Protocol MIB. VLAN support for the Nortel BayStack Hub 350 and 450 devices is provided by the BayAccelarApp. See the Nortel BayStack Hubs (2292) management module guide for more information.

During the modeling process, device models are created for switches and routers that support 802.1Q, Cisco ISL, or Cabletron SecureFast VLANs, or the Nortel Rapid City MIB (rc.mib).

SPECTRUM then creates application models for each device depending on the protocol the device is running, and the MIBs containing VLAN information that the device supports.

If AutoDiscovery does not create a complete map of the physical (port-to-port) connectivity, you must complete the map by manually modeling the connections or devices that are missing. SPECTRUM’s VLAN functionality will not work properly if all devices and connections are not mapped.

For complete instructions on using AutoDiscovery, refer to the AutoDiscovery User Guide (0727).

Manual Modeling or Editing the VLAN Topology Model

Instead of using SPECTRUM’s AutoDiscovery feature, you may choose to model your VLAN domain manually. Also, if there are inaccuracies in the VLAN topology model that AutoDiscovery has created, you must manually edit the VLAN topology model.
Refer to the *How to Manage Your Network with SPECTRUM (1909)* guide and *Getting Started With SPECTRUM for Administrators (0985)* for instructions on how to create models and connections manually.

When editing or modeling the VLAN topology model, the following information concerning model placement and connectivity should be noted:

- In order to be able to view the spanning tree and physical connectivity of the entire VLAN domain within one view, you should put all switches that are a part of the domain into a single container model as long as the number of switches does not overwhelm the available space in the window.

- All switches in a VLAN domain must use the same protocol. However, in order to see switches from multiple domains within a single SpectroGRAPH topology view regardless of the protocol they support, you can model switches of multiple domains in a single SPECTRUM container.

- Make sure that each switch is directly connected to all of its physical neighbors. This is done by entering the Device Topology view of each switch to see if its ports are connected to the correct devices. If there is a problem with a port, cut the incorrect device from the port and then paste the correct device onto the port.

- To correctly establish physical connectivity between two devices, the ports of each device must reference each other. If device A (port 1) is connected to device B (port 4), you must enter device A’s Device Topology view to paste B into its port 1, and then enter device B’s Device Topology view to paste A into its port 4.
Managing VLANs

This section describes the VLAN specific views that you can use to monitor a VLAN.

In This Section
The VLAN List View [page 12]
The VLAN Topology Spanning Tree Overlay [page 14]
The User View [page 15]
The Port View [page 16]
The VLAN Domain Options View [page 18]

The VLAN List View

This view shows a list of all of the VLANs configured on all of the switches contained in the topology view from which it was launched. If all of the switches in a domain are modeled within a single container, the VLAN List view shows all VLANs in the domain. However, if only a fraction of the switches are in this container, the entire VLAN domain will not be shown in the list.

To access the VLAN List view:

1. Open a Topology view that contains at least one VLAN switch.
2. Select View > VLAN List to display the VLAN List dialog.
The VLAN List view allows you to search for a specific VLAN by VLAN Name or VLAN ID. To use the find feature:

1. Click on the ID/Name selector button and select either ID or Name as the search criteria.
2. Enter the search criteria.
3. Click the **Find** button.
4. The find feature will highlight the row in the list that matches the ID or the name (or partial name) that you have entered.

The **User View** button brings up [The User View](#page_15).
The **Port View** button brings up [The Port View](#page_16).
The **Options** button brings up [The VLAN Domain Options View](#page_18).
The **Close** button dismisses the VLAN List view and the VLAN Topology Spanning Tree overlay.
The VLAN Topology Spanning Tree Overlay

When the VLAN List view is displayed (see The VLAN List View [page 12]), the spanning tree overlay is automatically visible over the Topology view. The spanning tree overlay highlights the VLAN device models and the pipes between those models, showing trunk connections between switches.

The Spanning Tree protocol prevents looping on the network. If redundant paths exist between switches, one path is designated as the primary path and the other path as the backup path. Using the spanning tree overlay, the primary path between two switches is shown with solid, bold pipes. The backup path between two switches depicting a blocked port is shown with a dashed line.

Figure 4: Topology View with the Spanning Tree Overlay
The User View

The User View provides read-only Name, IP, Condition, Switch IP, and Switch Port information for each of the users in the selected VLAN. Users are endpoint devices modeled in SPECTRUM that are connected to a VLAN switch port.

To display the User View for a particular VLAN, select a VLAN from the list and then click **User View**.

The following fields are displayed in the User View:

- **Name**: Model name of the host model connected to the switch port.
- **IP**: The IP address that SPECTRUM uses to get management information from the host.
- **Condition**: Contact Lost, Major, Minor, Initial, Maintenance, or Suppressed
- **Switch IP**: The IP address of the VLAN switch.
- **Switch Port**: The number of physical ports to which the user is connected.

To search for a specific Name, IP, Condition, Switch ID, or Switch Port:
1. Click on the selector button which allows you to choose one of the field names as a search criteria.

2. Enter the search criteria.

3. Click the **Find** button.

The find feature will highlight the first row in the list that matches the search criteria that you have entered.

The **Close** button dismisses the User view.

### The Port View

The Port view provides read-only Name, IP, Interface, Trunking, and State information about the ports in the selected VLAN. To display the Port view for a particular VLAN, select a VLAN from the VLAN List view (see [The VLAN List View](page 12)) and then click **Port view**.

**Figure 6: Port View**

<table>
<thead>
<tr>
<th>Name</th>
<th>IP</th>
<th>Interface</th>
<th>Trunking</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>192.168.92.34_1</td>
<td>192.168.92.34</td>
<td>10</td>
<td>no</td>
<td>Forwarding</td>
</tr>
<tr>
<td>192.168.92.34_10</td>
<td>192.168.92.34</td>
<td>11</td>
<td>no</td>
<td>Forwarding</td>
</tr>
<tr>
<td>192.168.92.34_11</td>
<td>192.168.92.34</td>
<td>12</td>
<td>no</td>
<td>Forwarding</td>
</tr>
<tr>
<td>192.168.92.34_12</td>
<td>192.168.92.34</td>
<td>13</td>
<td>no</td>
<td>Forwarding</td>
</tr>
<tr>
<td>192.168.92.34_13</td>
<td>192.168.92.34</td>
<td>14</td>
<td>no</td>
<td>Forwarding</td>
</tr>
<tr>
<td>192.168.92.34_14</td>
<td>192.168.92.34</td>
<td>15</td>
<td>no</td>
<td>Forwarding</td>
</tr>
<tr>
<td>192.168.92.34_15</td>
<td>192.168.92.34</td>
<td>2</td>
<td>no</td>
<td>Forwarding</td>
</tr>
<tr>
<td>192.168.92.34_16</td>
<td>192.168.92.34</td>
<td>9</td>
<td>no</td>
<td>Forwarding</td>
</tr>
<tr>
<td>192.168.92.34_17</td>
<td>192.168.92.35</td>
<td>1</td>
<td>yes</td>
<td>Forwarding</td>
</tr>
<tr>
<td>192.168.92.34_18</td>
<td>192.168.92.35</td>
<td>13</td>
<td>no</td>
<td>Forwarding</td>
</tr>
<tr>
<td>192.168.92.34_19</td>
<td>192.168.92.35</td>
<td>14</td>
<td>no</td>
<td>Forwarding</td>
</tr>
</tbody>
</table>

- **Name**: Name of the switch port.
- **IP**: IP address of the switch.
- **Interface**: Port number of the switch port.
• **Trunking**: Indicates whether the port transmits packets for multiple VLANs.

• **State**: There are six possible spanning tree states defined below:
  
  • **Disabled**: Management disabled this interface. No traffic is received or forwarded while the interface is disabled.
  
  • **Listening**: The switch is not adding information associated with this interface into its database. The switch is monitoring traffic while preparing to move from the learning to the forwarding state.
  
  • **Learning**: The switch is learning addresses on this interface. The switch enters the learning state when the switch’s database is created (during startup or after being deleted), or when the spanning tree algorithm detects a network topology change.
  
  • **Forwarding**: The switch is operating and this interface is forwarding traffic.
  
  • **Blocking**: This interface will not forward any traffic through the switch because a loop condition has been detected by the spanning tree algorithm.
  
  • **Broken**: This interface is malfunctioning.

To search for a specific Name, IP, Interface, Trunking or State:

1. Click on the selector button which allows you to choose one of the field names as a search criteria.

2. Enter the search criteria.

3. Click the **Find** button.

The find feature will highlight the first row in the list that matches the search criteria that you have entered.

**Close** dismisses the User view.
The VLAN Domain Options View

Click on the **Options** button in the VLAN List view (see [The VLAN List View](#page_12)) to bring up the **VLAN Domain Options** dialog box.

**Figure 7: Options**

![VLAN Domain Options dialog box]

To specify the time interval (in minutes) at which SPECTRUM reads switch tables to determine port VLAN membership, enter a value in the **SPECTRUM VLAN Modeling Configuration Interval** text field. The following values are recommended:

- 10 - 15 minutes for highly dynamic environments in which servers and/or workstations are modeled.
- 60 minutes for more static environments.

**Note:** A value of zero (0) means that no reading of the switch tables will take place.

Click **Reconfigure Now** to immediately read the switch tables to determine current VLAN membership.

If your environment is set up to use a third-party VLAN configuration tool, the **External VLAN Configuration Application** field allows you to specify the path to launch this tool.
Once the path has been specified, click the **Launch VLAN Config Tool** button to access the application.

To close the view, select **File > Close**.
VLAN Fault Isolation

In general, SPECTRUM’s fault isolation intelligence relies on physical connectivity to determine the data path from the SpectroSERVER to each managed device. When the SpectroSERVER fails to contact any device, the device’s physical neighbors’ status is checked. If the neighbors can be contacted, SPECTRUM assumes the device to be at fault. If the neighbors cannot be contacted, SPECTRUM looks for a fault elsewhere.

When working with a VLAN domain that uses a one-armed router configuration and includes the SpectroSERVER, SPECTRUM has additional fault isolation capabilities. In this scenario, if the connection to the one-armed router goes down, and the server loses contact with managed devices in other VLANs, the fault status of the managed devices is suppressed.

In the figure below, the SpectroSERVER is in VLAN 1. The NT host machines A, B, and E are in VLAN 2 and NT host machines C and D are in VLAN 1. Both VLANs are in the same VLAN domain. Router X is acting as a one-arm router to forward packets from one VLAN to the other.

When the link to this router goes down, contact is lost between the SpectroSERVER and of the NT host machines in VLAN 2. However, the SpectroSERVER maintains contact with the switches connecting these NT hosts to the network and the NT host machines in VLAN 1. SPECTRUM’s traditional physical layer fault isolation would normally create a critical alarm for each of the lost NT host machines in addition to the critical alarm on the one-armed router. However, with VLAN modeling enabled, SPECTRUM will identify router X as a bounding router of VLAN 1 and VLAN 2. Before alarming on the NT host machines, SPECTRUM will try to contact all routers that are considered bounding routers for both VLANs. In this case, the only bounding router is router X. If no bounding routers are reachable, then the alarms on the NT hosts are suppressed, and the fault is isolated to the router.
Router X: A one-armed router

Figure 8: Fault Isolation
Index

Numerics
802.1Q [6], [10]

B
BayAccelarApp [10]

C
Cabletron SecureFast [6], [10]
Cisco ISL [6], [10]

N
Nortel BayStack Hub 350 and 450 [10]
Nortel Rapid City MIB (rc.mib) [10]

O
one-armed router configuration [6], [7], [20]

S
spanning tree states [17]
specify modeling configuration interval [18]
switch tables [18]

T
third-party VLAN configuration tool [18]

V
VLAN membership [18]